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Chapter 371 

Mixed Models Tests for 
Two Means at the End of 
Follow-Up in a 3-Level 
Hierarchical Design 
(Level-3 Randomization) 
Introduction 
This procedure calculates power and sample size for a three-level hierarchical design which is randomized at the 
third level. Each subject (level-2 unit) is measured at several time points (level-1 units) and the goal of the study 
is to compare the group means of at the final time point, i.e., at the end of follow-up.  

The study is assumed to be longitudinal, so repeated measurements (level-1 units) are nested in patients (level-2 
units) which are nested in clinics (level-3 units).  

Each clinic (level-3 unit) is randomized into one of two intervention groups; e.g., treatment and control. 

Technical Details 
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.4.4, pages 209-211. The 
longitudinal mixed model that is adopted is a re-parameterized version of fixed-slope model 

𝑌𝑌𝑖𝑖𝑖𝑖 = 𝛽𝛽0 + 𝜉𝜉𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖 + 𝜏𝜏𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 + 𝛿𝛿𝑓𝑓𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑢𝑢𝑖𝑖 + 𝑢𝑢𝑗𝑗(𝑖𝑖) + 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖 

in which the time variable is rescaled using 𝑆𝑆𝑘𝑘 = 𝑇𝑇𝑘𝑘 − 𝑇𝑇𝑒𝑒𝑒𝑒𝑒𝑒. Therefore, the 𝑆𝑆𝑘𝑘 become −𝑇𝑇𝑒𝑒𝑒𝑒𝑒𝑒 , … , 0. 

Let 𝛽𝛽0′ = 𝛽𝛽0 + 𝜏𝜏𝑇𝑇𝑒𝑒𝑒𝑒𝑒𝑒 and 𝛿𝛿𝑒𝑒 = 𝜉𝜉 + 𝛿𝛿𝑓𝑓𝑇𝑇𝑒𝑒𝑒𝑒𝑒𝑒. We assume that, because of randomization, 𝜉𝜉 = 0. The mixed model 
then becomes 

𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 = 𝛽𝛽0′ + 𝛿𝛿𝑒𝑒𝑋𝑋𝑖𝑖 + 𝜏𝜏𝑆𝑆𝑘𝑘 + 𝛿𝛿𝑓𝑓𝑋𝑋𝑖𝑖𝑆𝑆𝑘𝑘 + 𝑢𝑢𝑖𝑖 + 𝑢𝑢𝑗𝑗(𝑖𝑖) + 𝑒𝑒𝑖𝑖𝑖𝑖 

where 

𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 is the continuous response of the kth level-1 unit of the jth level-2 unit of the ith level-3 unit. 

𝛽𝛽0 is the fixed intercept. 

𝛿𝛿𝑓𝑓 is the treatment-by-time interaction effect. It can be ignored since 𝑆𝑆𝑘𝑘 is zero at the final 
observation because of the re-parameterization. 
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𝛿𝛿𝑒𝑒 is the intervention effect at the end of the study. By construction, 𝛿𝛿𝑒𝑒 = 𝜇𝜇1 − 𝜇𝜇2 at the final time 
point. This is the term that will be tested for significance. 

𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖 is an indicator variable that is 1 if ith unit is in group 1 and 0 if it is in group 2. 

𝑆𝑆𝑘𝑘 is the rescaled time value. It is assumed that 𝑆𝑆𝑘𝑘 = 𝑘𝑘 − (𝑀𝑀− 1) for all i and j. 

𝜉𝜉 is the intervention effect at baseline and is assumed to be zero. 

𝑢𝑢𝑖𝑖 is the level-3 random intercept effect for the ith level-3 unit. It is distributed as 𝑁𝑁(0,𝜎𝜎32). 

𝑢𝑢𝑗𝑗(𝑖𝑖) is the level-2 random intercept effect for the ith level-3 unit. It is distributed as 𝑁𝑁(0,𝜎𝜎22). 

𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖 is a random error term which is distributed as 𝑁𝑁(0,𝜎𝜎𝑒𝑒2). 

𝜎𝜎2 is the variance of Yijk, where 𝜎𝜎2 = 𝜎𝜎𝑒𝑒2 + 𝜎𝜎22 + 𝜎𝜎32. 

𝜌𝜌1 is the correlation among level-1 units which are in a particular level-2 unit. For fixed models like 
this, 𝜌𝜌1 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶�𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 ,𝑌𝑌𝑖𝑖𝑗𝑗𝑗𝑗′� = (𝜎𝜎22 + 𝜎𝜎32)/𝜎𝜎2. 

𝜌𝜌2 is the correlation among level-2 units which are in a particular level-3 unit. For fixed models like 
this, 𝜌𝜌2 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶�𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 ,𝑌𝑌𝑖𝑖𝑗𝑗′𝑘𝑘′� = (𝜎𝜎32)/𝜎𝜎2. 

C1 is the number of level-3 units assigned to group 1. 

C2 is the number of level-3 units assigned to group 2. 

K is the number of level-2 units per level-3 unit. 

M is the number of level-1 units per level-2 unit. 

𝑉𝑉(𝑇𝑇) is ∑ �𝑇𝑇𝑗𝑗 − 𝑇𝑇��𝑀𝑀
𝑗𝑗=1

2 /𝑀𝑀. Note that 𝑉𝑉(𝑆𝑆) = 𝑉𝑉(𝑇𝑇) and 𝑆𝑆̅ = −𝑇𝑇�. 

𝐶𝐶𝐶𝐶(𝑆𝑆) is �𝑉𝑉(𝑆𝑆)/𝑆𝑆̅ . 

𝐶𝐶(3) is 1 + (1−𝜌𝜌1)
𝐶𝐶𝐶𝐶(𝑆𝑆)2𝑓𝑓3

 . 

The test of significance of the Xi term in the mixed model analysis is the test statistic of interest. It tests the 
difference of the two group means. Since these are asymptotic results, the specific type of mixed model is not 
stated. 

Assume that 𝛿𝛿𝑒𝑒 = 𝜇𝜇1 − 𝜇𝜇2 is to be tested using a z-test (large sample). The statistical hypotheses are 𝐻𝐻0: 𝛿𝛿𝑒𝑒 = 0 vs. 
𝐻𝐻𝑎𝑎: 𝛿𝛿𝑒𝑒 ≠ 0. The test statistic is the regression coefficient of the Xi term in a mixed model.  

The power can be calculated using 

𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = Φ

⎩
⎪
⎨

⎪
⎧

�
𝛿𝛿𝑒𝑒
𝜎𝜎 ��

𝐶𝐶2𝐾𝐾𝐾𝐾

�𝑓𝑓3 �1 + 1
𝜆𝜆�𝐶𝐶(3)�

− Φ(1 − 𝛼𝛼/2)

⎭
⎪
⎬

⎪
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where 𝜆𝜆 = 𝐶𝐶1/𝐶𝐶2 and 𝑓𝑓3 = 1 + 𝑀𝑀(𝐾𝐾 − 1)𝜌𝜌2 + (𝑀𝑀 − 1)𝜌𝜌1. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. The parameters that may be 
selected are 𝜇𝜇1 − 𝜇𝜇2, Power, C1, K, and M.  

Under most situations, you will select either Power to calculate power or C1 to calculate the number of level-3 
unit. Occasionally, you may want to fix C1 and C2 and calculate K or M. 

Note that the value selected here always appears as the vertical axis on the charts. 

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary 
search is made using an iterative procedure until an appropriate value is found. This search considers only integer 
values of C1, K, or M. 

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected.  

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered. 

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5. 

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true 
null hypothesis is rejected.  

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. 
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha 
that represents the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01. 
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Sample Size  

C1 (Level 3 Units Assigned to Group 1) 
This is the number of level 3 units in group 1 (treatment group). The sample size for this group is equal to 
Ceiling(C1 * K * M). 

Examples of level 3 units are schools, clinics, hospitals, or cities. 

A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated 
measurements are the level 1 units. 

This value must be a positive integer. 

You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list. 

C2 (Level 3 Units Assigned to Group 2) 
This is the number of level 3 units in group 2 (control group). The sample size for this group is equal to 
Ceiling(C2 * K * M). 

Examples of level 3 units are clinics, hospitals, or cities. 

A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated 
measurements are the level 1 units. 

This value must be a positive integer. 

Using Multiples of C1 
If you simply want a multiple of the value for group 1, you would enter the multiple followed by "C1", with no 
blanks. If you want to use C1 directly, you do not have to enter the leading "1". For example, all of the following 
are valid entries: 

C1 2C1 0.5C1 1.5C1. 

You can use a list of values such as "10 20 30" or "C1 2C1 3C1". 

K (Level 2 Units Per Level 3 Unit) 
This is the average number of level 2 units in each level 3 unit. Examples of level 2 units are classrooms or 
patients. 

A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated 
measurements are the level 1 units. 

This value must be a positive number that is at least 1. 

It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up 
to the next largest integer. 

You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list. 

M (Level 1 Units Per Level 2 Unit) 
This is the average number of level 1 units in each level 2 unit. Examples of level 1 units are repeated 
measurements or students. 

A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are 
the level 1 units. A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and 
repeated measurements are the level 1 units. 

This value must be a positive number that is at least 1. 

It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up 
to the next largest integer. You can use a list of values such as "5 10 15". A separate analysis will be run for each 
element in the list. 
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Effect Size 

μ1 - μ2 (Mean Difference) 
Enter one or more values for the mean difference where μ1 is the mean of group 1 at the final measurement and 
μ2 is the mean of group 2 at the final measurement.  

This sample size estimate assumes that the mean difference at the beginning is zero. This assumption is 
reasonable when the subjects are randomly assigned to groups at the beginning of a study. This procedure 
assumes that the times are 0, 1, 2, ..., (M-1) and the value of T at the last measurement point is (M-1).  

The power is the probability of detecting a difference of at least this amount. This value is not necessarily the true 
difference. Rather, it is the difference you want to detect. 

The difference, μ1 - μ2, can be any non-zero value (positive or negative). Since this procedure uses a is a two-
sided test statistic, you will get the same result with either positive or negative values. 

Syntax 
You can enter a single value such as 1 or a series of values such as 1 2 3 or 1 to 2 by 0.2.  

When a series of values is entered, PASS will generate a separate calculation result for each value of the series. 

σ (Standard Deviation) 
Enter the standard deviation of an individual observation, Yijk. This standard deviation applies for both groups. 

Note that σ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7 
9 or 1 to 9 by 2. 

Press the small ‘σ’ button to the right to obtain calculation options for estimating the standard deviation.  

ρ1 (Correlation Among Level 1 Units) 
 

This is the correlation of each pair of level 1 units in a particular level 2 unit. 

Possible values are from 0 to just below 1. For fixed slope models, ρ1 ≥ ρ2. Typical values are between 0.0001 
and 0.5. 

You may enter a single value or a list of values. 

ρ2 (Correlation Among Level 2 Units) 
 

This is the correlation of each pair of level 2 units in a particular level 3 unit. 

Possible values are from 0 to just below 1. For fixed slope models, ρ1 ≥ ρ2. Typical values are between 0.0001 
and 0.5. 

You may enter a single value or a list of values. 
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Example 1 – Calculating Power 
Suppose that a longitudinal trial is planned in which there will be repeated measurements (level-1) which are 
nested in patients (level-2) which are nested in clinics (level-3). This analysis will calculate the power for 
detecting the difference between two interventions in heart rate. The researchers want to compare the end of 
follow-up heart rate of subjects who take a new drug to that of subjects who take a standard drug. Their 
experimental protocol calls for a baseline heart rate measurement, followed by administration the drug, followed 
by three additional measurements ten minutes apart. They want to be able to detect a difference of 10 in the final 
measurement heart-rate means between the two treatments. They want a sensitivity analysis by considering a 
range of differences from 9 to 11.  

The analysis will be a mixed model of continuous data. The following parameter settings are to be used for the 
power analysis: μ1 - μ2 = 9, 10, 11; σ = 9.2; ρ1 = 0.1; ρ2 = 0.05; K = 5; M = 5; α = 0.05; and C1 = C2 = 2 to 6 by 
2.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Mixed Models Tests for Two Means at the End of Follow-Up in a 3-Level Hier. Design 
(Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open 
Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ........................................................ Power 
Alpha ............................................................... 0.05 
C1 (Level 3 Units Assigned to Group 1) ......... 2 4 6 
C2 (Level 3 Units Assigned to Group 2) ......... C1 
K (Level 2 Units Per Level 3 Unit) .................. 5 
M (Level 1 Units Per Level 2 Unit) .................. 5 
μ1 - μ2 (Mean Difference)............................... 9 10 11 
σ (Standard Deviation) ................................... 9.2 
ρ1 (Correlation Among Level 1 Units) ............ 0.1 
ρ2 (Correlation Among Level 2 Units) ............ 0.05 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 
Numeric Results for a Three-Level Hierarchical Mixed Model ─────────────────────────────── 
 
  Group 1 Group 2   Mean Diff 
  Level 3 Level 3 Level 2 Level 1 at End of Std Level 1 Level 2 
 Total Units Units   Units Units Follow-Up Dev    Corr    Corr 
Power N C1 C2 K M μ1 - μ2   σ      ρ1      ρ2 Alpha 
0.6652 100 2 2 5 5 9.00 9.20 0.100 0.050 0.050 
0.9215 200 4 4 5 5 9.00 9.20 0.100 0.050 0.050 
0.9851 300 6 6 5 5 9.00 9.20 0.100 0.050 0.050 
0.7555 100 2 2 5 5 10.00 9.20 0.100 0.050 0.050 
0.9633 200 4 4 5 5 10.00 9.20 0.100 0.050 0.050 
0.9958 300 6 6 5 5 10.00 9.20 0.100 0.050 0.050 
(report continues) 
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Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the total number of level-1 units. 
C1 and C2 are the number of level-3 units assigned to groups 1 and 2, respectively. 
K is the average number of level-2 units per level-3 unit. 
M is the average number of level-1 units per level-2 unit. 
μ1 - μ2 is the difference in the two group means at the final measurement time: M - 1. 
σ is the standard deviation of the level-1 responses. 
ρ1 is the correlation among level-1 units in a particular level-2 unit. 
ρ2 is the correlation among level-2 units in a particular level-3 unit. 
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal. 
 
 
Summary Statements ───────────────────────────────────────────────────────── 
The total number of observations, 100, were obtained from 2 level-3 units in group one and 2 
level-3 units in group two with an average of 5 level-2 units per level-3 unit and an average 
of 5 level-1 units per level-2 unit. The study achieves 67% power to detect a difference of 
9.00 between the (fixed) group means at the last time. The standard deviation of level-1 units 
is 9.20. The correlation of level-1 units within a level-2 unit is 0.100. The correlation of 
level-2 units within a level-3 unit is 0.050. A test based on a mixed-model analysis is 
anticipated at a significance level of 0.050. 
 

This report shows the power for each of the scenarios.  

Plots Section 
 

      
 

These plots show the power versus the level-3 count for the three values of the difference. 
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Example 2 – Calculating Sample Size (Number of Clinics) 
Continuing with the last example, suppose the researchers want to determine the number of clinics (level-3 units) 
needed to achieve 90% power for the values of the mean difference.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Mixed Models Tests for Two Means at the End of Follow-Up in a 3-Level Hier. Design 
(Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open 
Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ........................................................ C1 (Number Level 3 Units) 
Power .............................................................. 0.90 
Alpha ............................................................... 0.05 
C2 (Level 3 Units Assigned to Group 2) ......... C1 
K (Level 2 Units Per Level 3 Unit) .................. 5 
M (Level 1 Units Per Level 2 Unit) .................. 5 
μ1 - μ2 (Mean Difference)............................... 9 10 11 
σ (Standard Deviation) ................................... 9.2 
ρ1 (Correlation Among Level 1 Units) ............ 0.1 
ρ2 (Correlation Among Level 2 Units) ............ 0.05 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a Three-Level Hierarchical Mixed Model ─────────────────────────────── 
 
  Group 1 Group 2   Mean Diff 
  Level 3 Level 3 Level 2 Level 1 at End of Std Level 1 Level 2 
 Total Units Units   Units Units Follow-Up Dev    Corr    Corr 
Power N C1 C2 K M μ1 - μ2   σ      ρ1      ρ2 Alpha 
0.9215 200 4 4 5 5 9.00 9.20 0.100 0.050 0.050 
0.9011 150 3 3 5 5 10.00 9.20 0.100 0.050 0.050 
0.9466 150 3 3 5 5 11.00 9.20 0.100 0.050 0.050 
 

This report shows the power for each of the scenarios.  
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Example 3 – Validation using Ahn, Heo, and Zhang (2015) 
Ahn, Heo, and Zhang (2015) page 211 provide a table in which several scenarios are reported. We will validate 
this procedure by the first row of the table. The following parameter settings were for the analysis: power = 0.80; 
μ1 - μ2= 0.3; σ = 1; ρ1 = 0.1; ρ2 = 0.05; K = 4; M = 5; and α = 0.05. These settings resulted in a value of C1 and 
C2 (their N3

(0)) of 35 and an attained power of 0.806. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Mixed Models Tests for Two Means at the End of Follow-Up in a 3-Level Hier. Design 
(Level-3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open 
Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ........................................................ C1 (Number Level 3 Units) 
Power .............................................................. 0.80 
Alpha ............................................................... 0.05 
C2 (Level 3 Units Assigned to Group 2) ......... C1 
K (Level 2 Units Per Level 3 Unit) .................. 4 
M (Level 1 Units Per Level 2 Unit) .................. 5 
μ1 - μ2 (Mean Difference)............................... 0.3 
σ (Standard Deviation) ................................... 1 
ρ1 (Correlation Among Level 1 Units) ............ 0.1 
ρ2 (Correlation Among Level 2 Units) ............ 0.05 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a Three-Level Hierarchical Mixed Model ─────────────────────────────── 
 
  Group 1 Group 2   Mean Diff 
  Level 3 Level 3 Level 2 Level 1 at End of Std Level 1 Level 2 
 Total Units Units   Units Units Follow-Up Dev    Corr    Corr 
Power N C1 C2 K M μ1 - μ2   σ      ρ1      ρ2 Alpha 
0.8062 1400 35 35 4 5 0.30 1.00 0.100 0.050 0.050 
 

PASS calculates the same values of C1 and power— 35 and 0.806. 
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